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Abstract

The goal of this procedure was to harvest the #4 abdominal mammary glands from female nulliparous mice in order to assess ECM expression
and ductal architecture. Here, a small pocket below the skin was created using Mayo scissors, allowing separation of the glands within the
subcutaneous tissue from the underlying peritoneum. Visualization of the glands was aided by the use of 3.5x-R surgical micro loupes. The pelt
was inverted and pinned back allowing identification of the intact mammary fat pads. Each of the #4 abdominal glands was bluntly dissected
by sliding the scalpel blade laterally between the subcutaneous layer and the glands. Immediately post-harvest, glands were placed in 10%
neutral buffered formalin for subsequent tissue processing. Excision of the entire gland is advantageous because it primarily eliminates the
risk of excluding important tissue-wide interactions between ductal epithelial cells and other microenvironmental cellular populations that could
be missed in a partial biopsy. One drawback of the methodology is the use of serial sections from fixed tissues which limits analyses of ductal
morphogenesis and protein expression to discrete locations within the gland. As such, changes in ductal architecture and protein expression in
3 dimensions (3D) is not readily obtainable. Overall, the technique is applicable to studies requiring whole intact murine mammary glands for
downstream investigations such as developmental ductal morphogenesis or breast cancer.

Video Link

The video component of this article can be found at https://www.jove.com/video/56512/

Introduction

Breast cancer is characterized by a substantial degree of tissue fibrosis1,2,3,4. Referred to as the ECM, this non-cellular entity is found in varying
degrees in all tissues and is primarily comprised of a complex meshwork of fibrillar and non-fibrillar collagens, elastin, and glycoproteins in
addition to various signaling molecules that are sequestered in this matrix. Under homeostatic conditions, the deposition and degradation
of the ECM is tightly controlled.5 During breast tumorigenesis, the balance of ECM deposition and degradation is disrupted. As such, breast
tumors have been reported to express abundant ECM proteins such as collagens, fibronectin and tenascin-C amongst others.6 The abnormal
expression of these proteins in addition to increased patterns of matrix crosslinking has been documented to promote breast tumor progression,
metastasis and therapy resistance1,3,4,7,8,9.

To assess ECM composition and ductal morphology, isolation of intact mammary glands was performed. Here, we used female nulliparous
mice deficient for caveolin-1, an integral membrane protein which has been linked to an aggressive breast tumor signature10,11,12, and control
female nulliparous B6 mice. Histological processing and staining of these tissues permitted the identification of several ECM proteins along with
characterization of ductal morphology.

Overall, the isolation of whole, intact mammary glands gives researchers the opportunity to investigate tissue-wide morphological or cellular
changes occurring in response to exogenous or endogenous factors. Drawbacks of the technique are associated with analyses of 2 dimension
(2D) tissue sections as opposed to a 3D perspective, which would yield a more complete picture of the complex morphology of the ductal
tree. Given the complexity of cell-cell and cell-ECM interactions that take place in the mammary gland, the isolation of whole, intact glands is
advantageous for efficiently analyzing ductal morphology and protein expression in various regions of the murine mammary gland.

Protocol

Procedures involving animal subjects in this protocol were reviewed and approved by the Institutional Animal Care and Use Committee of the
Philadelphia College of Osteopathic Medicine and all techniques were conducted under strict ethical guidelines.
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1. Sample Procurement and Processing

1. Select appropriate animal subject and place into a CO2 chamber. For this experiment, use 8-10 week old female nulliparous B6.Cg-
Cav1tmMIs/J and C57BI/6J.

2. Turn on gas flow to 30-40%. Once the animal is visibly unconscious after about 2 min, open the gas valve to full pressure for an additional 5
min.
 

NOTE: Confirm animal death by observing visible signs of breathing (e.g. movement of the chest) for a period of 10 min after cessation of
CO2 delivery. If the animal is still alive, it may be placed back in the CO2 chamber. Cervical dislocation may also be used although it is not
recommended as blood may accumulate around the mammary glands interfering with the dissection and results.

3. Following sacrifice, pin carcass in a supine position and saturate with 70% ethanol.
4. Pinch the pelt just above the pubis using forceps and nick with small surgical scissors. Rotating the scissors, cut the pelt along the ventral

midline moving caudal to cranial.
5. With larger scissors or a hemostat, bluntly dissect the subcutaneous fascia bilaterally, using caution not to puncture the peritoneum. Cut

along the horizontal margins at both distal ends of the incision.
6. Pin the pelt flaps open and spray again with 70% ethanol.

 

NOTE: Although the use of 70% ethanol permitted better visual distinction between the gland and the surrounding subcutaneous tissue, be
careful to avoid drying of the tissue as a result of use of this solution. To avoid drying, remove the gland in a time frame not to exceed 4 min.
As an alternative to 70% ethanol, the investigator may also substitute a general isolate buffer, such as 1x PBS, to avoid tissue desiccation.

7. Locating the mammary glands of interest, slide a #4 scalpel blade along the inside of the pelt flaps, cutting the mammary gland and
associated cutaneous adipose free from the dermis.
 

NOTE: 3.5x surgical micro loupes may aid in easier visualization of the glands.
8. Immediately submerge newly isolated gland in conical tube containing 10:1 solution-tissue volume of 10% neutral buffered formalin for 24-48

h.
 

NOTE: Depending on intent of study, many alternative fixatives may be used such as paraformaldehyde, ethanol for genomic studies, and
commercially available RNA preserving buffers.

9. Follow institutional protocols for paraffin embedding, submit samples to a vendor for processing, embedding, and slicing/slide mounting.
Section tissues at 5 µm.
 

NOTE: Due to excess adipose surrounding gland, consider removing 100-200 µm of tissue before sectioning and staining.

2. Tissue Staining

1. Immunohistochemistry
1. Place slides to be stained on heat block set at 58 ˚C for 1 h to melt paraffin.

 

CAUTION: Melting paraffin wax may run off slide. Monitor closely or place wipe under slide to capture runoff wax.
 

NOTE: This step is not essential and may be skipped. If results are not as expected, adding this step back may improve results.
2. Incubate slides in a slide jar containing 100% xylene for 30 min ensuring complete submersion. Repeat once.

 

NOTE: At this point, visual inspection should be performed to ensure that tissue sections are free of adipose tissue and paraffin. If
additional adipose tissue or wax is evident, the slide should be re-submerged in xylene. Use caution to minimize added exposure to
xylene as this can cause shrinkage of the tissue.

3. Rehydrate tissues in a slide jar containing 100% ethanol for 10 min. Repeat once.
4. Move slides to a slide jar containing 95% ethanol for 10 min. Repeat once.
5. Move slides to a slide jar containing 75% ethanol for 5 min.
6. Move slides to a slide jar containing 50% ethanol for 5 min.
7. Boil 10 mM sodium citrate solution (pH 6.0) in a hot plate or a microwave and pour into Coplin jar.

 

CAUTION: Carefully monitor solution while heating and take care to avoid boil over. Container will be very hot. Use protection to avoid
burns.

8. Slowly place slides into Coplin jar, ensuring complete submersion, and incubate at 100 °C for 10 min to retrieve epitopes. Remove and
carefully dry slides.

9. Draw a barrier around tissue with a hydrophobic marker.Add enough endogenous enzyme blocker (hydrogen peroxide and sodium
azide, available commercially) to cover tissue and incubate for 10 min.

10. Submerge slides in 1x phosphate buffered saline (PBS) for 10 min.
11. Add enough 10% donkey serum in 1x PBS to cover tissue and incubate for 1 h at room temperature in a humidified chamber.

 

NOTE: The experiment can be paused here by storing the slides in the humidified chamber at 4 °C overnight. While donkey serum was
found to yield optimal staining results, the investigator may wish to test different sera such as bovine serum albumin (BSA), goat serum
or horse serum to determine optimal results. If using BSA, the investigator should prepare this fresh before use.

12. Decant excess blocker from slides and add properly diluted primary antibody in 1% serum directly to slides ensuring that the tissue is
evenly covered in solution. Incubate for 30 min at room temperature in a humidified chamber.
 

NOTE: This step may be continued for longer time durations with humid chamber stored at 4 °C. Make sure to include proper negative
control slides (e.g. a slide with no primary antibody, known antigen-negative tissue, etc.) at this step.

13. Carefully wash slides by flowing about 1 mL of diH2O over tissue and incubate in 1 change of 1x PBS for 5 min.
14. Decant excess PBS and add enough horseradish peroxidase label to cover tissue and incubate for 30 min in a humidified chamber.

 

NOTE: At this step, the investigator may wish to proceed to fluorescent staining using fluorescently conjugated secondary antibodies. If
this is desired, the next steps described should be modified accordingly.

15. Carefully wash slides by flowing about 1 mL of diH2O over tissue and incubate in 1 change of 1x PBS for 5 min.
16. Make diaminobenzidine (DAB) plus chromogen solution according to the manufacturer suggested ratio and mix by vortex.

 

NOTE: Many ready-made kits are commercially available aside from the one used in this protocol.
17. Decant excess buffer from slides and add 2-3 drops (10-50 µL) of chromogen stain directly to tissues and incubate for 5 min in humid

chamber. Carefully wash slides by flowing about 1 mL diH2O over tissue.
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CAUTION: DAB-chromogen is highly toxic. Avoid direct contact of stain with skin and collect flow off in hazardous waste.

2. Hematoxylin and Eosin (H&E)
1. Following final rinse after chromogen incubation, submerge slides in Harris hematoxylin for 2-2.5 min. Rinse slides gently under tap

water for 1-2 min.
 

NOTE: Take care to avoid direct jet of water onto tissues.
2. Submerge slides for 2-3 s in differentiation solution (0.25 mL of hydrochloric acid in 100 mL of 70% ethanol). Rinse slides gently under

tap water for about 1-2 min.
3. Submerge slides in blue agent (4.5 mg calcium carbonate in 100 mL tap water, pH adjusted to 9.4) for 60 s. Rinse slides in 95%

ethanol for 30 s.
4. Submerge slides in alcoholic eosin Y for 2-3 min.
5. Dehydrate tissue in 2 changes of 95% ethanol for 1 min each.
6. Dehydrate tissue in 1 change of 100% ethanol for 1 min.
7. Carefully dry slides with a lint-free wipe. Apply 1 drop (about 100-200 µL) of synthetic, non-aqueous, resin-based mounting media to

slide and apply coverslip.
 

NOTE: If a different staining method was elected, a different mounting media may be required. For instance, if the investigator chose a
fluorescent-conjugated secondary antibody, an aqueous mount would be more ideal.

8. Allow slides to set overnight at room temperature.

3. Picrosirius Red (PSR) Staining
1. Select slides to be stained and follow immunohistochemistry protocol through step 6 (50% ethanol soak).
2. Submerge slides in PSR stain for 1 h.
3. Submerge slides in 0.5% acetic acid for 1-2 s, twice to differentiate stain.
4. Dehydrate tissues in 2 changes of 95% ethanol for 1 min each.
5. Dehydrate tissues in 1 change of 100% ethanol for 1 min.
6. Clear slides by briefly submerging in 100% xylene for about 3-4 s.
7. Carefully dry slides with a lint-free wipe. Apply 1 drop (about 100-200 µL) of synthetic, non-aqueous, resin-based mounting media to

slide and apply coverslip.

3. Sample Analysis

1. Ductal Analysis
1. Select slides stained for α-SMA. Using a light microscope fitted with a camera-mounted objective, collect representative images at 20X

magnification.
2. Using ImageJ (NIH), distinguish and count ducts in each image. These can be enumerated manually or one may assign a numerical

score to individual ducts. To assign a numerical score, open ImageJ and select Plugins. Next select Analyze and choose Cell Counter
from the drop down menu. Click Initialize then highlight Type 1 to begin labeling ducts. When finished, select Results to view the ductal
count.
 

NOTE: Take care to verify structures are ductal and not vascular.
3. In 'Set Measurement' options, check 'Perimeter' and 'Area".
4. Using the freehand polygon tool, draw a line around each duct at the myoepithelial compartment (visibility aided by α-SMA stain).

Select 'Measure' and record the perimeter and area.
5. Again using the freehand polygon tool, draw a line along the apical side of the ductal epithelium within the interior of the lumen. Select

'Measure' and record the perimeter and area.
6. Subtract the perimeter of the luminal compartment from the perimeter of the myoepithelial compartment in order to obtain the

circumference of the ductal epithelium. Subtract the area of the luminal compartment from the area of the myoepithelial compartment to
obtain the area of the ductal epithelium.

2. Immunohistochemistry Analysis
1. Upload brightfield images to an analytical software, such as ImageJ or FIJI Suite.

 

NOTE: This protocol outlines the steps for staining analysis using ImageJ and the IHC Toolbox plugin.
2. Open the IHC Toolbox from the Plugin menu. In the "Select Model" combo box that opens, select appropriate stain (i.e. H-DAB, PSR,

etc.). Select the "Color" option to isolate the stain. This will open a result window.
 

NOTE: This method is appropriate if a protein of interest is located in the extracellular or cytosolic spaces, or is bound to the plasma
membrane. If the protein of interest is nuclear, selecting "Nuclei" will prompt the plugin to analyze the image for positively stained
nuclei.

3. Use the Color Chooser Slide to ensure proper isolation of the stain without background inclusion or excessive stain exclusion.
 

NOTE: If the automatic mode is unable to detect the stain or does not result in acceptable images, draw a square Region of Interest
(ROI) over an identified stained region. On the IHC Toolbox window, select "Train" to direct the plugin to the appropriate target.

4. Convert the image to 16-bit. Go to Image → Type → 16 bit.
5. Threshold the image. Go to Image → Adjust → Auto Threshold.
6. Set the image measurement scale by drawing a line ROI directly over the scale bar in the image then assigning the length. To set the

scale bar, go to Analyze → Set Scale. Input the number of pixels per the desired unit of length (e.g. 120 pixels per 50 µm).
7. Measure the resultant area and mean grey value. Go to Analyze → Set Measurements and collect the measurement by clicking

Analyze → Measure.
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Representative Results

Female mice have 5 pairs of mammary glands. Specifically, there is one pair of cervical glands (#1), two pairs of thoracic glands (#2 and #3), one
pair of abdominal glands (#4), and 1 pair of inguinal glands (#5) (Figure 1A). Here, we isolated the #4 glands as they are readily identifiable. In
some circumstances, both #4 and #5 glands were isolated together as distinction between the two was difficult. To isolate intact #4 abdominal
mammary glands, the pelt was pinned and carefully separated from the underlying peritoneum, revealing the location of the #4 glands indicated
by an arrow (Figure 1B). The #4 glands were carefully excised and inspected for the presence of any residual subcutaneous or muscle tissue.
Although these were not identifiable in our isolated glands (Figure 1C), we did note substantially more subcutaneous tissue in fibronectin-stained
glands from tissue blocks in which tissue had not been removed prior to sectioning (e.g. superficial) (Figure 1D) versus glands in which 100-200
µm of tissue from the tissue block had been removed prior to sectioning (e.g. deep) (Figure 1E). To gain a better understanding of tissue fibrosis
in the mammary gland in response to exogenous or endogenous factors, the investigator may wish to compare fibrosis in superficial versus deep
cuts of the gland. For other analyses, it may be advantageous for the investigator to section the tissue block in half before proceeding to tissue
slicing and staining if substantial subcutaneous and/or muscle tissue is present following gland dissection.

Following isolation, glands were fixed in 10% neutral buffered formalin, processed and sectioned for staining. The steps used for analyzing
collagen expression in addition to other proteins of interest are depicted in Figure 2A. Representative samples from the ECM proteins collagen,
fibronectin and tenascin-C are shown in Figure 2B. Arrows in each of the images show the presence of ducts in these tissues (Figure 2B).

To quantify morphological features of ducts, it is important to treat the histological sections with care as improper handling may result in damaged
tissues and ducts that are not measurable. Examples of improper handling may be running buffers or water directly on the tissues, using buffers
at an improper temperature or leaving tissue samples in harsh buffers such as sodium citrate and acetic acid for a longer period of time than
specified in the protocol. An example of a tissue section in which tissue damage has occurred is shown in Figure 3A. Here, extensive damage
to the tissue can be readily observed as breakage points in the ducts (Figure 3A). A section such as this cannot be used for analyses of ductal
structures. An example of an intact tissue specimen where the ducts are measurable and quantifiable is shown in Figure 3B. Here, the ducts
are not only characterized by the surrounding fibronectin-stained stroma, but are also characterized by the presence of a dense population of
epithelial cells lining the lumen of the ducts (Figure 3B). It is important to note that during development, the mouse mammary gland contains a
single duct at birth from which lateral secondary branches sprout, forming a more complicated ductal tree which undergoes a series of branching
and regression with each estrous cycle 13. Although we have not taken into consideration the estrous cycle of the animals in these experiments,
the investigator may wish to do so in order to obtain information on ductal numbers independent of the estrous cycle. The investigator is referred
to a protocol by Caligioni14 in which the stage of the estrous cycle can be visibly determined. With regard to quantifying ducts, the presence of
multiple ductal structures in these histological sections is not indicative of multiple unique ducts, but is rather indicative of a more developed
ductal tree resulting from ductal outgrowth. To enumerate ducts, one may use an image analysis software such as ImageJ (NIH) to assign a
number to individual ducts in a tissue section. The investigator may wish to enumerate ducts as alterations in ductal numbers, which may be
indicative of developmental abnormalities or a pathological condition. With respect to our study, we believe the increased number of ducts, a
result of ductal outgrowth, is related to the loss of caveolin-1 which may drive the aberrant expression of growth factors such as insulin growth
factor 1 (IGF-1), a known mediator of mouse ductal growth 15.

In addition to the presence of intact ducts, several ducts contain branches, indicated by arrows in a fibronectin-stained section (Figure 3C). For
the purpose of this analysis, these ductal branches should not be considered as a separate ductal structure. While evaluating and measuring
ducts, it is important to distinguish ducts from vascular structures. Vascular structures can not only be identified by the presence of an endothelial
monolayer lining the lumen, but also by the presence of a-nuclear, eosinophilic structures indicative of red blood cells (RBC) within the lumen
(Figure 3D). Although the presence of eosinophilic structures within lumens indicates RBC and suggests vasculature, the displacement of RBC
during gland collection throughout tissue sections is possible. It is advisable to confirm vascular structures using the endothelial marker CD31.
An example of a histological section stained with CD31 is shown (Figure 3D). In order to quantify ductal circumference and area, vectors in
ImageJ (NIH) can be assigned to outline the myoepithelial border (circumference) and the luminal border in α-SMA-stained tissue section. α-
SMA, a marker of smooth muscle cells, was used as it stains the myoepithelial cells which line ducts. In the image shown, the red line shows
the myoepithelial border while the blue line shows the luminal border (Figure 3E). The region between the stromal and luminal compartments,
shown in the schematic, is the area occupied by the total stromal tissue plus the ductal epithelial cells (Figure 3E).
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Figure 1: Isolation of whole, intact mammary glands for histological analyses. (A) Following animal sacrifice, the pelt was carefully
removed and pinned back to expose the mammary glands located between the dermis and peritoneum. The schematic shows the relative
positions of the cervical (#1), thoracic (#'s 2 and 3), abdominal (#4) and inguinal (#5) glands. (B) The #4 abdominal glands, shown in the
dissected animal and indicated by the red arrows, were isolated. (C) Representative example of #4 abdominal glands isolated from a nulliparous
female B6 mouse. (D) Substantial subcutaneous tissue from glands in which tissue had not been removed from the paraffin block prior to
sectioning (e.g. superficial) was apparent following staining for the ECM protein fibronectin. (E) Considerably less subcutaneous tissue and more
fibronectin stained stromal tissue were observed from glands in which 100-200 µm of tissue had been removed from the paraffin block prior to
sectioning (e.g. deep). Histological sections are from representative samples. Please click here to view a larger version of this figure.

 

Figure 2: Histological processing and staining. (A) Schematic representation of the steps used for histological processing. A different series
of steps was utilized for analyses of collagen expression. (B) Representative images of the ECM proteins collagen, fibronectin and tenascin-C
from the glands of female nulliparous caveolin-1 deficient animals. Arrows for collagen, fibronectin and tenascin-C indicate the dense stroma
lining the ducts. PSR: Picrosirius Red. Fn: fibronectin. Ten-C: tenascin-C. Please click here to view a larger version of this figure.
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Figure 3: Analyses of ductal architecture. (A) A fibronectin stained section illustrates extensive tissue damage. This is marked by the
presence of breaks in the ductal structures (arrows). (B) A fibronectin stained section illustrates the presence of intact ductal structures which
are marked by the presence of lumens surrounded by one or more layers of epithelial cells and a surrounding stroma. Arrows indicate individual
ductal structures. (C) A fibronectin-stained image highlights the presence of ductal branches, which are indicated with arrows. Note the continuity
of these with the lumen of the larger ductal structure. (D) Vascular structures (red arrows), characterized by a single layer of cells and the
presence of a-nucleated eosinophilic structures indicative of red blood cells, are frequently observed in proximity with the ducts (black arrow).
Low magnification is shown in the image on the left and a corresponding high magnification image is shown on the right. These images were
stained with H&E and tenascin-C. CD31 was used as a positive marker for the endothelial cells lining the vascular structures. Shown is a large
vascular structure in which CD31 positive cells are visible lining the lumen of the vessel. Low magnification is shown in the image on the left
and a corresponding high magnification image is shown on the right. (E) Ductal circumference was measured in an α-SMA-stained image using
a vector (shown in red) to outline the myoepithelial compartment while ductal area was measured using a vector (shown in blue) to outline
the luminal compartment. The region in between the stromal and luminal compartments was classified as the ductal area. Scale bar = 50 µm.
Schematic of a ductal structure highlighting the areas from which the perimeter and area were measured. Ten-C: tenascin-C. The histological
section in Figure E was modified from: Thompson C et al.16  Please click here to view a larger version of this figure.

Discussion

In the paper, we have described a technique to isolate intact mouse mammary glands for downstream histological analyses of ECM expression
and ductal morphology. With respect to analyses of ductal morphology, this methodology enables the rapid investigation of ductal architecture
based off of stained histological sections. Other methods of ductal analyses rely on injections of dyes to enable visualization of the ductal tree,
methods which may be technically challenging and time consuming.

In breast cancer, the ECM has been reported to be abnormal.1,2,6,9 Specifically, changes in the abundance and/or cross-linking patterns of the
ECM have been reported to influence tumor progression, metastasis and therapy resistance3,4,6,7,8,9. In addition, changes in the ECM milieu
have also been reported to alter ductal epithelial cell morphology and proliferation17, potentially leading to a situation favoring tumor initiation.
While we utilized a caveolin-1 deficient animal model to assess changes in ECM expression and ductal morphology following loss of caveolin-1,
one may apply this methodology in any mouse model. To assess ECM expression patterns and ductal architecture, we describe a technique
to isolate whole, intact mammary glands for downstream histological analyses. Results from this methodology yielded robust analyses of ECM
expression and glandular morphology. We found that analyzing ECM expression, especially fibronectin, from sections in which 100-200 µm of
superficial tissue was removed prior to sectioning and staining yielded a more complete picture of glandular fibrosis. Additionally, we found that
use of donkey serum as opposed to BSA yielded better quality histological samples in which non-specific staining was substantially reduced.

For analyses of ductal architecture, it is important to use sections in which tissues are intact and contain ducts in which breakage points, a
result of improper tissue handling and sectioning, are not evident. Furthermore, it is important to correctly distinguish ductal branches, another
parameter that an investigator may wish to measure, and vascular structures which can easily be identified by their monolayer endothelium
and eosinophilic structures within the lumen in addition to staining with CD31. While ducts were observed in sections stained for various ECM
proteins, the myoepithelial marker αSMA and H&E counterstaining, which highlighted the cellular component of the ducts, enumeration of ducts
and any associated branches is achievable with H&E stained tissue sections alone. For more detailed analyses of ductal morphogenesis or
analyses of the presence of pre-neoplastic and/or neoplastic lesions, an investigator may wish to utilize confocal imaging to evaluate live ex-
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vivo tissues. In this instance, the same technique in which whole glands are excised can be applied with the fixation and tissue processing steps
eliminated.

Critical steps in this protocol include the use of surgical micro loupes which not only enabled the precise identification of the #4 abdominal
glands, but additionally permitted the dissection of the gland from the overlying dermis and underlying peritoneum. The exclusion of substantial
subcutaneous tissues and muscles reduced adipose-associated interference in staining and histology. In addition, to better identify ECM
expression changes in the gland, we found it useful to remove 100-200 µm of the tissue block, which helped eliminate residual adipose tissue.
Although whole mammary gland isolation provides information on tissue wide changes in stromal protein expression and ductal morphogenesis,
the described technique is limited to analysis of serial sections from fixed, paraffin embedded tissues. To establish the degree to which changes
in ductal branching have occurred, whole mount imaging of live, ex-vivo tissues would be necessary. Here, an investigator could use Cre-
Lox to design custom, conditional fluorescent reporter conjugations to study gland specific protein interactions or utilize a dye to illuminate
the ductal tree prior to imaging18. In addition to this, further analysis of proteins of interest in the entirety of the gland would necessitate the
use of western blot or mass spectrometry or other high-throughput techniques such as cross-linking immunoprecipitation (CLIP) or chromatin
immunoprecipitation (ChIP). In this instance, whole glands would be dissected, sectioned into small pieces and processed accordingly for the
downstream analyses. In addition, one may also use fluorescent imaging on tissue sections. This technique would be ideal for analyzing multiple
proteins and protein expression co-localization in the same tissue.

In summary, we describe a technique that offers the rapid isolation of whole, intact mammary glands and provides further details on histological
processing and ductal analyses. Future applications of this technique could investigate ECM expression and associated changes in ductal
morphology in tumor-bearing animals. Furthermore, analyses of collagen orientation and fiber diameter, information which may be useful for
analyzing tissue density, may also be performed on PSR stained sections.
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